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WVDOT GIS Level 2 
Description 

The WVDOT GIS Level 2 seminar is the second of a cumulative series. The seminar 

introduces the learner to geoprocessing tasks: manipulating attribute tables; dissolving 

a feature around an attribute;  continuing the use of reference and default 

geodatabases,. The exercises assume familiarity with the ESRI ArcMap 10 data display 

skills introduced in Level 1. 

The workbook is divided into sections for each of the four seminars plus a reference 

section. Each seminar section gives a brief description of the topic then explores the 

topic with guided exercises. Additional information at the end of the seminar exercises 

expands topic briefs covered during the seminar. 

The reference section contains descriptions of icons on various toolbars; definition of 

the Federal Information Processing System (FIPS) codes for each US State and 

Territory and all 55 West Virginia Counties; how to connect to spatial databases using 

an Internet connection; and descriptions of various projected reference systems by the 

US Geologic Survey. 

Objectives 

At the conclusion of this seminar, the learner will have exercised the ability to: 

1. Replicate existing spatial data. 

2. Share symbology and labeling. 

3. Determine a feature data set’s coordinate geometry. 

4. Use a SQL query for attribute selections. 

5. Perform calculations on coordinate geometries. 

6. Use geoprocessing tools to create new geometries. 

7. Label data using expressions. 

8. Create and use buffers. 

9. Perform spatial queries. 

10.**Optional** Determine routes between multiple points of interest. 
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Seminar Workflow 
1. Critique Level 1 map creation. 

2. Introduce various types of geodatabases. 

3. Create a default geodatabase. 

4. Make a working copy of a feature data set in the default geodatabase. 

5. Adding fields and enter data into an attribute table.  

6. Use three types of attribute queries to modify an attribute table. 

7. Use geoproccessing tools to create new feature data sets. 

8. Determine the coordinate geometries of geospatial feature datasets. 

9. Create complex labels using expressions. 

10.Use buffers to increase the reliability of spatial queries. 

11. Perform complex queries. 

12.**Optional** Map routes between points of interest and determine the travel time. 

13.Map the results of a series of queries. 
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Level 1 Map Review 
Use the following guide to evaluate the map created during the Level 1 seminar. 

Map Evaluation Guide

Cartographic Requirement
Is the rationale for the map evident? 😟 😐 😀

Does the map meet the substantive objective? 😟 😐 😀

How is the “look and feel” of the map (ie, the affective objective)? 😟 😐 😀

Does the map address the intended audience? 

  
😟 😐 😀

Does the map address the expected educational level of the audience? 😟 😐 😀

Does the map meet the expected conditions (media, distance, light, etc)? 😟 😐 😀

Cartographic Compilation and Design
Have all required themes and features been included? 

😟 😐 😀

Does the map have appropriate figure-ground organization? 
😟 😐 😀

Is there appropriate visual hierarchy among and within each theme? 😟 😐 😀

Is there appropriate visual emphasis on the important theme(s)? 😟 😐 😀

Is the symbology for qualitative and quantitative data effectively applied? 😟 😐 😀

Do the colors and symbols support the substantive and affective objectives? 😟 😐 😀

Do the font styles, size and color support the substantive and affective objectives? 😟 😐 😀

Are the symbols and labels legible? 😟 😐 😀

Are the symbols intuitive and easy to decipher or do they have good explanation? 😟 😐 😀

Is there appropriate use of graphics, images, text blocks, and supporting 
information? 😟 😐 😀

Can the map be placed in context both geographically and thematically? 😟 😐 😀

Is the map projection suited to the map’s purpose (equal area, conformal, etc)? 😟 😐 😀

Has the map projection been appropriately modified (central meridian, standard 
parallels, etc)? 😟 😐 😀

Subtotal 1 count
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Map Elements and Page Layout
Does the page look balanced? 😟 😐 😀

Do all the map elements support the substantive and affective objectives? 😟 😐 😀

Are the map elements placed logically on the page? 😟 😐 😀

Are the map and map elements aligned to the page and to each other? 😟 😐 😀

Does the map have appropriate borders? 😟 😐 😀

Orientation Indicator

Is the grid or graticule the appropriately aligned? 😟 😐 😀

Does the grid or graticule have appropriate labeling? 😟 😐 😀

Does the map require a north arrow? 😟 😐 😀

Scale Indicator

Is the scale appropriate to map? 😟 😐 😀

Is the scale bar appropriately designed, positioned and sized? 
😟 😐 😀

Are the scale units logical? 
😟 😐 😀

Legend

Have all the necessary symbols and details been included in the legend? 😟 😐 😀

Do the symbols in the legend appear exactly as they do on the map (size, 
color, etc)? 😟 😐 😀

Is there a logical structure related to the function of the legend? 😟 😐 😀

Are the patches, symbols, labels, and descriptions appropriately sized and 
positioned? 😟 😐 😀

Are the labels logical? 😟 😐 😀

Subtotal 2 count
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Map Elements and Page Layout - continued

Titles and Subtitles

Are the titles and/or subtitles relevant?
😟 😐 😀

Are the titles and/or subtitles suitably descriptive (area mapped, subject, 
date, etc)? 😟 😐 😀

Are the titles and/or subtitles suitably positioned and sized?
😟 😐 😀

Production Notes

Are production notes included?
😟 😐 😀

Are the production notes dated correctly?
😟 😐 😀

Are the production notes placed appropriately?
😟 😐 😀

Have copyrighted sources been correctly attributed?
😟 😐 😀

Has the map’s assertion to copyright been included?
😟 😐 😀

Have attribution and/or revision details been included? 😟 😐 😀

Subtotal 3 count

Total count, subtotal 1 + 2 + 3

multiplier 	   x	  1 x	  3

Subscore

Final Score, 😐  + 😀   
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Geodatabases 
Geodatabases were briefly introduced in Level 1. The WVDOT GTI group maintains an 

extensive geodatabase for use by WVDOT employees. Please note that: 

The GTI_PUB_UTM geodatabase is a copy of the WVDOT GTI PUB UTM 
SDE database. These data should be used for training purposes only and 
should not be distributed. WVDOT employees should access GIS data 
through their server or SDE database to receive updated, current data. 

Instructions on how to connect to these data through their server or SDE database are 

in the Reference section of the workbook binder. 

Types of Geodatabases 
ArcGIS stores information with several different database structures. Each has a place 
depending on the work environment. The geodatabase is a container used to hold a 
collection of datasets. There are three types:

1. File Geodatabases (.gdb) Stored as folders in a file system. Each dataset is 

held as a file that can scale up to 1 TB in size. This option is recommended over 

personal geodatabases. 

2. Personal Geodatabases (.mdb) All datasets are stored within a Microsoft 

Access data file, which is limited in size to 2 GB. 

3. ArcSDE Geodatabases—Stored in a relational database using Oracle, Microsoft 

SQL Server, IBM DB2, or IBM Informix. This is a multiuser geodatabase requiring 

the use of ArcSDE (Spatial Database Engine) and is unlimited in size and 

numbers of users. 
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Key 
Characteristics

ArcSDE 
Geodatabase

File 
Geodatabase

Personal 
Geodatabase

Description

A collection of 
various types of 
GIS datasets held 
as tables in a 
relational 
database 
This is the 
recommended 
native data format 
for ArcGIS stored 
and managed in a 
relational 
database.

A collection of 
various types of 
GIS datasets held 
in a file system 
folder 
This is the 
recommended 
native data format 
for ArcGIS stored 
and managed in a 
file system folder.

Original data 
format for ArcGIS 
geodatabases 
stored and 
managed in 
Microsoft Access 
data files 
This is limited in 
size and tied to the 
Windows operating 
system.

Number of 
Users

Multiuser 
Many readers and 
many writers 

ArcSDE can be 
licensed for use at 
three levels:
Personal ArcSDE 
Workgroup 
ArcSDE 
Enterprise 
ArcSDE

Single user and 
small workgroups 
Some readers and 
one writer per 
feature dataset, 
standalone feature 
class or table. 
Concurrent use of 
any specific file 
eventually degrades 
for large numbers of 
readers.

Single user and 
small workgroups 
with smaller 
datasets 
Some readers and 
one writer. 
Concurrent use 
eventually 
degrades for large 
numbers of 
readers.

Storage 
Format

Oracle 
Microsoft SQL 
Server 
IBM DB2 
IBM Informix

Each dataset is a 
separate file on disk 
A file geodatabase 
is a file folder that 
holds its dataset 
files.

All the contents in 
each personal 
geodatabase are 
held in a single 
Microsoft Access 
file (.mdb).

Size Limits 

Up to DBMS limits One TB for each 
dataset. Each file 
geodatabase can 
hold many datasets 
Each feature class 
can scale up to 
hundreds of millions 
of vector features 
per dataset.

Two GB per 
Access database 
Effective limit 
before 
performance 
degrades is 
typically between 
250 and 500 MB 
per Access 
database file.
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Platforms

Windows, Unix, 
Linux, and direct 
connections to 
DBMSs that can 
potentially run on 
any platform on 
the user's local 
network

Cross-platform Windows only

Database 
Administration 
Tools

Full DBMS 
functions for 
backup, recovery, 
replication, SQL 
support, security, 
and so on

File system 
management

Windows file 
system 
management

Notes

Requires the use 
of ArcSDE

Allows for optionally 
storing data in a 
read-only 
compressed format 
to reduce storage 
requirements

Often used as an 
attribute table 
manager (via 
Microsoft Access). 
Users like the 
string handling for 
text attributes.
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Creating a Geodatabase 
A geodatabase can be created from an existing design or data models established for 
transportation, tax Parcel, hydrography, and other applications. New objects can be 
created or loaded from existing shapefiles, coverages, CAD, etc.

When creating a geodatabase from scratch at a minimum answer questions like What 
kind of data will be used, what spatial reference will the data use, what rules govern 
data integrity, are there any relationships between data tables?

! A Feature Class is a collection of geographic features with the same geometry 

type (i.e., point, line, or polygon), the same attributes, and the same spatial 
reference. Feature classes allow homogeneous features to be grouped into a single 

unit for data storage purposes, for example, highways, primary roads, and secondary 

roads can be grouped into a line feature class named "roads." Feature classes can also 

store annotation and dimensions. The origination and destination points and the route 

lines that will be developed and analyzed are feature classes that fit this description. 

! A Feature Dataset is a collection of feature classes stored together that share the 

same spatial reference. Feature classes in a feature dataset share a coordinate system, 

and their features fall within a common geographic area. Feature datasets are used to 

help model spatial relationships between feature classes. The point and line feature 

classes will be organized into feature datasets. Non-spatial Tables 

Non-spatial tables contain only attribute data, that is there is no feature geometry. Non-

spatial tables can exist in a geodatabase as standalone tables. Non-spatial tables can 

be associated with other tables or feature classes. When a table is associated with a 

feature class, the feature class can be queried, selected, and symbolize features based 

on the data stored in the non-spatial table. 
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Exercise: Create a File Geodatabase 
This exercise will create a file geodatabase on the external USB drive, then make it the 

default geodatabase. Subsequent data files created during the Level 2 seminar will be 

to the default geodatbase. 

1. Open a blank map in ArcMap. 

2. Open the Catalog window and create folder connections to the external USB 

drive. 

3. In the Catalog window find the USB drive >Level 2 Data and right-click the 

folder and select New> File Geodatabase. 

4. Name the geodatabase something appropriate 

like My_L2 File Geodatabase.gbd. 

5. To make the file geodatabase you just created  

the default, right-click the geodatabase select 
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Make Default Geodatabase. To verify the newly created geodatabase is the 

default, look for the house icon on the storage tank and that the database name 

is bold. 

 Exercise: Create Working Copy of a Feature 
When modifying a feature data set’s attribute table, it is a good practice to make a copy 

and make modifications to the working copy rather that modify the original. For the 

following exercises, a copy of the WVDOT_GTI_PUB geodatabase will be maintained in 

its original state, and feature data sets will be copied and modified. 

1. Open the Level 2-1 Map Document. Ensure the Inset 

Map is the active reference frame. Work in the ArcMap 

Data View, not the Layout View.  

2. Ensure the My Level 2 File Geodatabase.gbd is still the default. The Counties 

data layer will be copied into this default geodatabase, as the county attribute table 

will be modified and used to create a new data layer representing each of the ten 

WVDOT districts. We will modify a copy, not the original. Right-click the 

geodatabase icon then select Import> Feature Class (Single)… 
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3. Select the Counties layer to import. Observe the correct Output Location. Name 

the Output Feature Class something relevant. The illustration uses MyCounties.  

4. A successful import will result in a new copy of the Counties in the default 

geodatabase. The MyCounties layer will be added to the map. 
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GIS Attribute Table Manipulation 
This exercise will introduce new GIS skills in creating and manipulating spatial 
information. The goal will be to create a feature dataset of ten polygons representing the 
WVDOT District outlines similar to the illustration. 

Optional challenge: For those wishing to extend their skill, locate each District 
Headquarter locations in each District.

The following exercises will:

1. Add a District field to the MyCounties feature dataset. 

2. Query the Attribute Table using Select by Attribute commands. Select the 

Counties making up a District using three different methods: 

•  Manually select counties on the map by pointing and clicking. 

•  Manually select counties from the attribute table. 

•  Query county names by constructing and executing SQL expressions. 

3. Create a polygon feature dataset of all ten WVDOT Districts using the Dissolve 

geoprocessing tool. 

4. Label each WVDOT Districts using a customized label expression. 
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Exercise: Add a Field to an Attribute Table 
A data field refers to a column in a database table. The field may contain data to be 
entered, displayed, or calculated from other fields. A field can contain a variety of data 
types.

Standard Data Types 

1. Short Integer - a small whole number 

2. Long Integer - a large whole number 

3. Float - floating point (decimal) number with a few decimal places. 

4. Double - a floating point (decimal) number with a lot of decimal places. 

5. Text - alphanumeric characters 

6. Date - time, date: dow, year, month 

Special Data Types. 

1. BLOB: Binary Large Object 
BLOB is binary dataset, and used for rasters, 

video, images and other large data types. 

2. GUID: Globally Unique Identifier 
GUIDs are used in databases as primary 

keys for database tables to ensure 

uniqueness between databases. 

Add a Field 

1. Right-click the MyCounties layer and select Open 
Attribute Table. 

2.Click the pulldown arrow to the 

right of the Field icon on the left 

side of the table header and 

select Add a Field… 

3.Name the field District with type Short Integer. The District 
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field will contain the District number. The data type is a short integer between. 

The Dissolve geoprocessing tool with use the District field for the dissolve key. 

Dissolve will combine all the District 1’s into a 

single polygon, all the 2’s, 3’s, etc. 

4. To make it easier to later select counties in 

the table, right-click the Name field header and 

select Freeze/UnFreeze Column. The county 

names will be frozen to the left side of the table 

display. 

5. Click and hold the District field heading until a small rectangle with an arrow 

appears. Drag the District column next to the Name column. 

6. The table is ready for population with the District number. We will use several 

attribute quires to locate the counties that make up a WVDOT district. 
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Queries 
Queries are used in almost every GIS analysis. As a fundamental tool in data 

exploration, queries provide the preparation for extracting certain features and looking 

for patterns in the data. Queries are commonly used to select features of interest; 

isolate features for additional analysis; explore spatial relationships; and look for 

patterns in features spatial distribution. 

In ArcMap, queries can be separated into attribute queries and spatial queries. An 

attribute query uses the records in an attribute table to test a particular condition, from 

matching text patterns like “find Wyoming county” to logical operators on quantities like 

“find all the populated places with 25,000 people or more. Spatial quires are based on 

relationships between data based on their location, such as “find all the hospitals within 

five miles of a bridge” or “locate all the US Highways in Disctrict 7”. 

Attribute Queries 

The exercise will use different selection methods to query the MyCounties date layer. 

Each method will be a text query to find county names. 

Exercise: Query by Attributes: Selection Methods 
The newly created District field will be populated with the WVDOT district number. 

Counties assigned to districts are displayed on a map in the Reference section of the 

workbook. 

Three methods of county selection will be used: 

1. Interactive graphic selection, use the select features tool and click on a 

county (hold the shift key for multiple selections). 

2. Interactive table selection, select the county record in the open attribute 

table  
(hold the control key for multiple selections) 

3. Constructing Select By Attributes Structured Query Language (SQL) 

queries. 
A SQL query has several advantages. It allows multiple selections by using 
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the logical OR to select by county name. Counties could also be selected by 

their FIPS code. Example: The District 1 select statement would look like :  

SELECT * FROM WVDOT_districts WHERE: “COUNTY” = 

‘Boone’ OR “COUNTY” = ‘Clay’ OR “COUNTY” = 

‘Kanawha’ OR “COUNTY” = ‘Mason’ OR “COUNTY” = 

‘Putnam’

Select statement can be saved and reused or shared with others. 

1. Use the interactive selection methods at least once to populate the District 

column. Click the Select Features tool !  from the Tools toolbar. Interactive 

selection can be set to 1) Create New Selection 2) Add to Current Selection 3) 

Remove from Current Selection 4) Select from Current Selection. For this 

exercise, select Add to Current Selection. 

2. The Select Features process can be made a bit easier by turing on the selected 

layer’s MapTips. Right-click the data layer and open and select 

Properties> Display> Show MapTips… check box. 

3. Add the Editor toolbar by selecting Customize> Toolbars> Editor from the main 

menu. 

4. Click Editor in the toolbar and select Start Editing. 

Although values can be entered into the table in 

immediate mode, there is no Undo if a mistake is 

made. By using the Editor, mistakes can be easily 

rectified. Note that a field can not be added to the 
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attribute table when the table is being edited. 

5.Click on each of the counties that make up a 

district. Either choose Add to The Current 
Selection as the Interactive Selection Method or 

hold the shift key with the Create New Selection 

method to add multiple counties to a selection. The 

illustration indicates that the District 1 counties of 

Boone, Clay, Kanawha, Mason, and Putnam 

selected. 
For interactive point and click selection, recall that the Select Features tool is in 

the tools toolbar. 

 

6. When all the counties of a 

particular district have been 

selected, open the attribute 

table and select the Show Selected Records button 

at the bottom of the Attribute Table window. 

7. Only the selected counties will be visible in the table. 
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8. Right-click the District column heading, choose Field Calculator, then type the 

District number in the calculator field. 

9. The Field Calculator will populate all the selected records with the number 

entered in the  calculator’s box. 

10.Clear the selected counties after each modification to the attribute table. 
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What could be the expectation if the selected features are not 
cleared after every attribute table modification? 

_____________________________________________________________________ 

Additional Attribute Table Modifications with the Field Calculators 

The Field Calculator permits numeric, string(text), or Date calculations on any selected 

record. Any number of values may be used in a calculated field. Calculations can use 

mathematical, trigonometric, alpha-numeric, date/time, or logical operators. Calculated 

expressions can be saved, loaded, and shared. Field calculations are limited to 500 

records/rows at a time. 

Exercise: Selecting and modifying a feature from the 
Attribute Table 

1. Open the MyCounties attribute table and click the Show All 

Records icon at the bottom of the table to display all the 

counties in the table. 

2. Clear the selected counties by clicking the Clear Selection icon in the table 

header or >Selection >Clear Selected Features. 
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3. From the Editor toolbar, select Save Edits after each time the counties in a 

District are successfully selected and the table updated. 

4. To use the table to Select the counties in a District, click on the empty box on the 

left-most row of the desired county in the attribute table. When selecting non-

contiguous rows, hold the Option key when clicking. 

5. Repeat the use of the Field Calculator to add district numbers into the attribute 

table for several Districts. 

6. From the Editor toolbar, select Save Edits after successfully selecting and 

updating the counties for a particular District. 

Exercise: Using a SQL Expression to Select features from the 
Attribute Table 

1. Select the counties in a District by constructing a SQL expression. From the 

main menu choose Selection> Select By Attributes…. 

2. Double-click the “Name field”. Click the Equal sign. Click the Get 

Unique Values button. 

3. Double-click the first county name in the desired District. Click the Or button. 

4. Double click the “Name” field, Click the Equal sign, Click the Or button. 

5. Continue adding all the counties in the desired District. For example, the 

District 1 SQL statement would be 
"NAME" = 'Boone' OR "NAME" = 'Clay' OR "NAME" = 'Kanawha' OR 

"NAME" = 'Mason' OR "NAME" = 'Putnam' 
6. Click the Verify button to check that the SQL expression syntax is valid. 
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7. Click Apply. The expression can be reused or 

shared by clicking the Save… button. Save the 

expression to your working folder as 

“District {district number}”. 

8. Close the Select By Attributes… dialog box and 

follow the instructions for using the 

Field Calculator to add a District number to the 

attribute table. 

9. To speed the process of selecting and modifying 

the attribute table, all ten District expressions 

have been saved and are available for use. 

Copy the District SQL expressions from the 

instructor’s shared folder. 

10.Load the expression for the desired District, execute the selection, and add the 

District number to the selected county MyDistricts field. 

11. Click the Stop Editing and Save Edits buttons when all counties have been 

assigned to a district. 

12.Check the attribute table for counties that do not have a district assignment. 

Construct a SQL statement that checks the MyDistricts attribute to see if it is non-

zero. 
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13.  Notice that 54 out of 55 counties are selected. 

14. Select	  by	  Attributes	  using	  the	  District	  10b	  SQL	  expression.	   
{“NAME LIKE ‘%owell’ OR “NAME”…}.	  

15.Save Edits when finished.  

Why did the selection for McDowell County fail? What could 
you do to prevent this behavior? 

______________________________________________________________________ 

______________________________________________________________________ 

What was different between the two SQL statements? What was 
the function of the LIKE operator? 

______________________________________________________________________ 

What are the advantages and disadvantages for each selection 
method? What are the advantages and disadvantages for each 
selection method? What are the advantages and disadvantages 
for each selection method? 

Manual point and click: 

advantages___________________________________________________________ 

disadvantages_________________________________________________________ 
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Manual selection from table: 

advantages___________________________________________________________ 

disadvantages_________________________________________________________ 

Expressions: 

advantages___________________________________________________________ 

disadvantages_________________________________________________________ 
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Geoprocessing 
Geoprocessing is used to manipulate spatial data. A typical geoprocessing operation 
takes an input dataset, performs an operation on the dataset, and returns the result of 
the operation as an output dataset. Common geoprocessing operations include 
geographic feature overlay, feature selection and analysis, topology processing, raster 
processing, and data conversion. Geoprocessing allows for definition, management, 
and analysis of information used to form decisions.

Geoprocessing Functions 

Dissolve 

Aggregates features based on specified 

attributes. Use dissolve tool when you want 

to remove boundaries or nodes between 

adjacent polygons or lines that have the same 

values for specified attributes. 

Merge 

Combines multiple input datasets of the 

same data type into a single output 
dataset. This tool can combine point, line, or 

Input 1 Input 2 Output

Attributes joined

intersect

union
Attributes not joined

clip

erase
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polygon feature classes or tables. Use the Append tool to combine input datasets with 

an existing dataset. 

Union 

Computes a geometric union of the input features. All 

features will be written to the output feature class with 

the attributes from the input features that overlap. 

Clip 

The Clip tool extracts input features that overlay 

the clip features. This tool is used to cut out a 

piece of one feature class using one or more of 

the features of another feature class, with the clip 

feature acting much like a cookie cutter. Clip is 

useful for creating a new feature class, also referred to as study area or area of interest 

(AOI) containing a geographic subset of the features in the input feature class. 

Erase 

Creates a feature class by overlaying the Input 

Features with the polygons of the Erase 

Features. Only those portions of the input 

features falling outside the erase features outside 

boundaries are copied to the output feature class. 

Intersect 

Use the intersect tool when you want to integrate two spatial data sets while preserving 

only those features falling within the spatial extent common to both layers.  
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Exercise: Create WVDOT District Boundaries with Dissolve 
1. The geoprocessing tool Dissolve will be used to 

aggregate each of the counties into districts based on the 

number in the District field.Choose the 

Geoprocessing> Dissolve tool from the menu. 

2. Choose the MyCounties feature class as the Input 

Feature. 

3. Use the default geodatabase as the Output Feature 

Class. 

4. Check the MyDistrict field as the dissolved field.  

5. Note that all other fields in the table will not be merged into the new output 

attribute table. 

6. During the Dissolve tool process, a box with show the progress of the Dissolve 

operation and a blue Dissolve banner will appear in the bottom right screen from 

the Data View window. 
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7. The county borders will dissolve into polygons defining the outside of 
each District. 

8. Open the attribute table of the newly created MyCounties_Dissolve 
feature class. The only remaining field from the MyCounty table is the 

MyDistrict field. Length(perimeter) and Area have been calculated 
for each District. The units are the same as the Data Frame. In this 

instance, UTM coordinates are meters 

and square meters. 

9. Rename the feature data set from 

MyCounties_Dissolve to MyDistricts by 
right-clicking the data set in the 

geodatabse and selecting Rename, or by pressing the F2 shortcut 

key. 

How many polygons were created from the 55 counties? Was 
this the behavior you expected? 

__________________________________________________________________  

�29



How might other geoprocessing tools be used with WVDOT 
data? 

__________________________________________________________________  

Exercise: Create and populate a perimeter and area field in 
units other than that of the data frame. 

1. ArcMap can Calculate the perimeter and area of each district polygon 

in miles and area in square miles. 
To begin, add two floating point 

numeric fields to hold the results, 

and name them something relevant  

like Perim_mi and Area_mi. 
2. Right-click the field name and 

select Calculate Geometry... . 
3.Set the 

desired Property 

and Units. 

4. The resulting attribute table should be similar to 

the illustration. 
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5. Prepare the Area numbers for later use as labels in a map. The 
precision of the display doesn’t require decimals, and a coma 

separator will help readability. To format the table entries to reflect 
this format: 

6.  Right-click the Area_mi field name and select Properties. Click the 

icon next to Numeric... . 
7. Set the decimal places to zero and check the Show thousands 

separators check box. 
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Exercise: Label using Expressions 
A more descriptive label for the District layer can be produced by creating a label 

expression. For this exercise the label will begin with the word “District” followed by the 

District number, then the area of the district on a line under the district number, ending 

with the area units label. 

1. Right-click on the data layer MyDistricts >Properties >Labels. 

2. Click the Label Features In This Layer box, select District as the Label Field. 

Examine the result. 

3. Click the Expression button in the Label window. Change the Parser to Python. 

4. Type “District “(include the double quotes around “District” and the space after District) 

+ [MyDistricts]. Press the Verify button to check the syntax and preview 

the label. 

5. Apply and examine the result in the data frame. 

6. Modify the label expression by displaying the district area followed by its units. 

Label values are concatenated with a plus sign. A carriage return can be inserted 

with ‘\n’. 
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7. Change the expression to make your labels look like the illustration. Save your 

SQL expression to the working directory. 

What expression did you use ? 

__________________________________________________________________ 

Layer Files 

A layer’s symbology can exist outside the map document as a Layer File (.lyr). A layer 
file makes it easy to keep the work invested in symbolization and to share a layer’s 

symbolization properties with other similar feature datasets and with other people. A 

layer file helps maintain a consistent symbology throughout a map document.  

When a layer file is added to a map, a layer file recreates the symbology exactly as it 

was saved, and, as long as there is access to the data referenced by the layer file, the 

referenced data set will be included in the spatial reference frame. 
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If the referenced data is not available or has been moved, the layer file’s symbology can 

still be imported from a layer file to an active data layer’s properties. 

The symbology can also be used on feature data set that were not referenced by the 

original layer file. 

Exercise: Importing and Exporting a Layer File’s 
Symbology 
A layer file can be used to copy previously defined symbology to an active data layer. 

The WV_Boundary.lyr is a dot-dash patterned border with a light yellow highlight and a 

hollow fill. 

Import the WV_Boundary.lyr symbology style to the MyDistricts feature: 

1. From the Data View, ensure the Inset Map is the active data frame. 

2. Right-click the MyDistricts layer and select Properties. Select the Symbology 

tab. 

3. Click the Import button to the right of the window. 

When saving a Layer File, a way to keep the data file 

accessible is to use a relative path to the layer's source 

data. The saved layer file will use the reference method to find the location of the source 

data using the Data Source Options setting specified in the map document properties. 

Set the Map Document Properties options from the main menu, 

> File> Map Document Properties> Pathname checkbox. The default setting 
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(unchecked) specifies that data sources be 

referenced with a full file path like E:\\Level 2 

data\myLayer.lyr. The checked option sets a 

path relative the the map file. Set this 

property before saving a layer file. 

Creating a Layer File: 

1.Symbolize the MyCounties polygons using 

the >Symbol Selector >Symbol 
Property Editor> Outline and select the 

Boundary, County symbol. 

2.Right-click the MyCounties layer and 

select >Save As A Layer File... . 

3.Navigate to USB drive > Working Folder 

and save the file. 

4. Test it by removing the layer from the map, and add it back by opening or 

dragging and dropping the layer file from the catalog to the data view.  
The layer file can also be used to import the symbology line work onto the 
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WV_outline layer by selecting the WV_outline Properties > Symbology then 

click the Import button. Navigate to and select the WV_outline .lyr file.  

Spatial Queries 

Spatial selections use two data layers and one spatial condition. The layer features 

being selected are compared spatially with the features in the second layer to determine 

which ones meet the criteria. Those that match the criteria are selected. 

Because feature classes vary in precision and geometric  accuracy it often happens that 

two objects that spatially overlap in the real world, such as a bridge and a roadway, will 

not match exactly when each feature’s x-y coordinates in the GIS are compared. It can 

be helpful then to specify a buffer around a feature when evaluating spatial proximity to 

provide a condition to ensure that features are close enough to provide a match. Recall 

that line features are infinitely narrow and points are infinitely small. Trying to search for 

a point intersection with a line may be impossible. A road centerline may never intersect 

a point representing a bridge. 

To expand this example, it would more likely to provide a spacial match between the 

road and bridge data sets if a buffer 50 feet wide was specified around a road 

centerline. The point position of a bridges would be close enough to be selected inside 

the road centerline buffer. In the same way, a 50 or 100 foot buffer can be created 

around the points representing the bridge locations, and road centerlines can be found 

by intersecting the lines with the bridge buffers. 

Basic spatial queries tests include containment, intersection, and proximity. 

Containment tests for one feature included wholly or partly: 

 A is identical to B is an exact match of A and B 

 A completely contains B is where B is completely surrounded by A 

 A contains B is where only part of B is inside A. 

 are completely within is the inverse of completely contains 

 are contained by is less stringent including wholly or partly inside 
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 have their center in is where the center of A lies inside feature B 

Clementini operators apply to the contain and are within conditions.These operators 

treat the boundary of a polygon as distinct from its inside and outside. it would not select 

features if only the boundary matches between two operators. 

Intersection is the most generic operator. An intersection returns any feature in A that 

touches, crosses, or overlaps any part of feature B. 

Proximity tests how close features in A are to features in B. The most generic test are 

within a distance of selects features in A that are wining a certain distance of B. 

Use the ArcGIS Help to better understand different spatial operators by searching in 

the index for Selection By Location, described. 

Exercise: Query by Location 
A series of queries, building in complexity will guide you in 

understanding the use of spatial queries. 

1. Open a map document with the Completed 

Routes (using the Completed Routes .lyr file) 

dataset and the Districts area layer created 

previously.. 

2. Prepare the only the layers that are to be selectable in the Table of Contents 

(TOC). Click on the List By Selection icon in the TOC. 

3. The selections will be made from the Roads 

layers and the MyDistricts layer. Click the 

selectable toggle icon - the leftmost of the 

three in the Selectable view. 

4. The objective of our query will be to 

determine the length of all the roads in 

District 10 that the WVDOH is responsible for 

maintaining. The first part is to “Select the Roads WVDOT is responsible for in 

District 10”. The query dialog can be thought of as: “select the features from 

any of the Roads layers within the one selected MyDistricts feature”.  The 
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source in this query is the District, and the target of the query is to select all 

the Roads within the source. 
Use the selection tool to manually select District 10. From the menu choose 

>Selection Select By Location. In the dialog box click any of the Roads 

layers as the target layer.  
Pull down and choose MyDistricts as the Source layer. 
Check the Use selected features (in our case the manually selected District 

10) box. 
Choose the are within the source layer feature as the selection method. 

5. Click the Apply button. The result should return all the roads in District 10. 

6. What is the length of all the roads WVDOT is responsible for in District 10. 

7. The selected roads could be exported to the Default geodatabase for 

additional analysis. To export the selection, Right-click the Roads >400k layer 

and choose >Data >Export Data>Selected Features. Click on the folder icon 

to browse to the default geodatabase, saving the data as something like 

My_D10_roads. A total of 3,619 road segments will be placed into the default 

geodatabase. 
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8. Add the exported layer to the map. 

9. The Completed Roads layer from the GTI_PUB geodatabase may be turned 

off or removed if desired.  

10.Unselect Scaled Roads 

General in the Drawing Order 

TOC entry. Notice that the 

exported road data has the 

default ArcMap symbology. Use 

the symbology we are familiar 

with from the Completed 

Roures .lyr file. 

11. Open the properties of the My_D10_roads layer. Under the symbology tab 

select Import. browse to and of the Roads layers and import Complete 

symbology definition. 

12. In the following Import Symbology Matching Dialog, retain SignSystem as 

the field that will be used to define the symbology. 

13.The road symbols are now defined under the Symbology tab. Since the 

single road layer created from the export is not set up to display different road 

classes at different scales, as does the grouped data sets, the size of the 

county road symbol should be reduced by clicking the symbol in the 

properties tab and choosing something less pronounced. 
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14.The symbols have been taken from the existing data layer, but the sign labels 

have not. Labels (road shields and sign symbols) can be assigned to each 

road classification as introduced in in Level 1. 

15.Save your work. 

How would you modify the table and create a query to answer: 
“How many miles of State (or US or County) Routes are there in 
District 10?” 

__________________________________________________________________ 

Solution: 

1. Open the attribute table and add a floating-point field Length_mi. 

2. Right-click the Length_mi column heading and Calculate Geometry, length 

in miles. 

3. Menu Selection >Select by Attributes > create a SQL query that selects the 

WV Route sign system number. Look up the WVDOT sign system reference 

number in the reference section of the workbook. 

4. Open the attribute table, use the Show Selected Records icon to show only 

the State Routes. Right-click the Length_mi column heading and select 

Statistics. 

5. The Sum of the length of all the selected roads is the answer. 
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Understanding Buffering 
The Buffer tool is a geoprocessing tool that generates an offset around an input feature 

at a specified distance. Buffers show the area that is within some distance of the input 

features. The tool is popular because the concept of buffering is easy to understand and 

buffering plays an important role in many geoprocessing workflows involving proximity 

or distance analysis (i.e., How far away are these things? or What features are within a 

distance of other features?). Because the Buffer tool is important in performing 

proximity tasks, a key goal for developers working with the tool has been to ensure that 

buffers accurately depict distances around features. There are two types of buffers, 

Euclidean and Geodesic. 

Euclidean Buffers 

A Euclidean buffer measure distance on a two-dimensional Cartesian plane. A 

Euclidean buffer is created by calculating straight-line distances between two points on 

a plane. Euclidean buffers appear as perfect circles when drawn on a projected flat 

map,  

Euclidean buffers are most common because they work well when analyzing distances 

around features that are concentrated in a relatively small area in a projected coordinate 

system (e.g., when all features are contained in one universal transverse Mercator 

[UTM] zone). 

In some situations, performing a Euclidean buffer will produce results that are not 

technically correct. The major danger when performing a Euclidean buffer on features 

stored in a projected coordinate system stem from the distortion of distances, areas, 

and the shapes of features caused by projected coordinate systems. 

For example, when using UTM (a projected coordinate system), features become more 

distorted the farther they are from the origin of the projection (i.e., the center of the UTM 

zone). When using a dataset that is not contained in a single UTM zone or when the 

buffer distance used is large enough to create offsets outside that zone, Euclidean 

buffers will yield incorrect results. 
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Euclidean buffers will be more accurate in the low-distortion areas and less accurate in 

the high-distortion areas. Geodesic buffers will be accurate in all areas. 

If a world projected coordinate system is used, distortion is often minimal in one area 

but significant in another. For instance, distortion in the Mercator World projection is 

minimal near the equator but significant near the poles. For a dataset that has features 

in both low- and high-distortion areas. Geodesic buffers are less common but provide 

more accurate buffer offsets for features that are more dispersed (i.e., cover multiple 

UTM zones, large regions, or even the whole globe). Geodesic buffers appear as 

perfect circles only on a globe. On two-dimensional maps, geodesic buffers often 

appear as irregular ellipses. 

Exercise: Creating a Buffer 
Exercise: Complex Queries 

Suppose we want to determine all the bridges 20 years or older along US Highways in 

District 10. The query will first select all the US Highways in District 10. The US Highway 

line features will be then be uses to select all the bridge point feature along the US 

highways. However, a line is an infinitely small feature and it is unlikely that the bridge 

point locations will end up precisely on the road centerline. We will provide some width 

to the road centerlines by creating a buffer around each US Highway segment as one 

method of increasing the reliability of the result. 

In preparation for our query to locate all the bridges, we will create a buffer of 100 feet 

on either side of all the US Highways that we find in District 10. 

1. Open the previous Map Document. Ensure the Detail Map is the active layer. 

Work in the Data View, not the Layout View. 

2. Select by Attribute the SignSystem code that represents US Highways. 

Reference the WVDOT code in the Reference section. 

3. From the main menu, >Geoprocessing >Buffer. Select My_D10_Roads as the 

Input feature. Change the output name to My_D10_USHwy_Buffer_100ft. 
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4. Press OK and the Buffer geoprocessing tool will activate. The resulting buffer is 

a polygon feature class.

!  

5. Add the bridges data layer from the WVDOT GTI PUB geodatabase >  

Transportation> Bridges feature dataset. 
6. From the menu, >Selection >Select By Location> Select Features From 

Bridges, with the source layer My_D10_USHwy_Buffer_100ft. There are a 

number of spatial selection methods that will satisfy the query. Apply the chosen 

query method. 

7. Examine the result in the Bridges attribute table. From the data set available at 

the time the workbook was written, the result found 71 bridges in contact (within 

100 feet) with a US Highways in District 10. Locate the YRBUILT attribute. Sort 

the column in ascending order. 

8. To complete the query, create a Select by Attribute SQL query to find all the 

bridges built before 1994. 
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What SQL expression did you use to find the 56 bridges in District 
10 that are 20 years or older? 

Is the SQL statement in the illustration correct? 

__________________________________________________________________ 
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Mapping Project 
Create a map showing the location of bridges fifty years old or older in the District of you 

choice. The bridges must be along a West Virginia State route. The map should provide 

the viewer with a small inset to indicate the District location, with the main map showing 

Interstate, US Routes, and State Routes properly symbolized and labeled. 

The 11x17 map will have holes punched 1-1/2 inches from the left edge, should display 

all the proper map elements: title; compass rose; symbolized bridges to differentiate 

older from younger; a main map scale in units divisible by 5 or 10; creator; and legend. 

Export the map as a pdf with 300 dpi, and name it “L2_your name”. 

Upload the completed pdf to the online learning center. 

NOTE for working on these map Documents within a state office with access to 

ArcGIS software. WVDOT currently supports a number of ArcMap versions from 10.0 

to 10.3 The ArcMap documents created at MUGS are version 10.1. These map 

documents can not be opened by the version 10.0 but can be opened in later 10.2 or 

10.3 versions. To save in a previous version, select Save A Copy > Save as type:  then 

select the desired prior ArcMap format. Save the map document with a name that 

provides information on the version, such as myMap_10_2 for a 10.2 version. This 

convention is useful for carry files between computers or exchanging with others.

!  
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Additional Information 
The Find Route Tool 
ArcMap provides the Find Route tool to find the quickest route between one or several 

points. Find Route provides an efficient way to evaluate routing requirements that have 

more than one stop; when a route is blocked, as when high water or bridges with 

insufficient load bearing capacity impede movement. 

When routing parameters have been set, Find Route can determine the quickest way 

to get to a single location or, several locations evaluating the best sequence with which 

to visit multiple stops. Find Route can produce 

• A shapefile of the route. 

• A list of travel directions for use when driving a route 

• Approximate driving time along the route. 

The list of stops used in calculating the route can be entered into Find Route in several 

ways. One or a combination of several method can be used: 

• Pointing and clicking on the map 

• Entering the address and ZIP Code of the stop 

• Choosing a point layer of stops 

• Selecting a point feature or features 

• Selecting a point graphic or graphics 

To open the Find Route dialog box, click the Find Route icon �  on the Tools toolbar. 

The Find Route Dialog 

The Find Route dialog box allows calculating routes between stops using a variety of 

methods: an optimized route, which is the most efficient travel route between defined 

stops; or find a route from stop to stop based on the specified order. Barriers can be 

placed along the street network to define where a route cannot travel through. 

The Find Route dialog box has four tabs: Stops, Barriers, Directions, and Options. 
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Stops 

The Stops tab defines the route stops by: 

• Typing the street address (the Find dialog box can be used) 

• Clicking the map with a mouse pointer 

• Added from a point layer 

• Adding from graphic points 

The order of the stops, saving stops, loading saved stops, and whether the route returns 

to a particular stop are set in the Stops window. Additionally, each stop can be assigned 

a stop duration or a time window, to account for the time spent fueling or load/unloading 

which affects the overall driving time when the trip start time is specified in the Options 

tab. 

Barriers 

The Barriers tab defines the barriers along the route by: 

• Typing the street address and using the geocoder 

• Clicking the map with a mouse pointer 

• Adding from a point layer 

• Adding from graphic points. 

Directions 

The Directions tab provides a list of the driving directions for the route, as well as the 

approximate driving time. The directions may be printed or copied to the clipboard and 

added to a document or text box. The Directions tab can also be used to zoom to the 

entire route or to a particular route segment. 

Options 

Many routing parameter are set in the Options tab window. 

• The routing service used to find the route  
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• The address locator used for reverse geocoding when clicking locations on the 

map when adding stops or barriers 

• Display a graphic point or callout for each stop or barrier 

• Symbolization of the route elements 

• Selecting to save routes, stops, or barriers and to add them to the ArcMap table 

of contents 

• Set route analysis parameters to find either the quickest or the shortest route 

• Alter the speed in any or all route segments 

• Set the trip start time and date 

• Defining network restrictions such as ferry and toll road usage and vehicle 

types 

• Choosing to optimize the stop order 

Routing Services and Address Locators 

Before calculating a route, a Routing Service must be defined in the Options tab. The 

routing service can be a file-based network dataset, an ArcGIS Online routing service, 

or an ArcGIS for Server routing service. These file formats are supported for file-based 

network datasets: SDC, shapefile, personal geodatabase, file geodatabase, and SDE. 
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